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Important Information

Warranty

The FP-1300 is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced by
receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the
warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected.
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire,
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying,

recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National
Instruments Corporation.

Trademarks

FieldPoint™, National Instruments

™

, NI"™, NI-CAN™, and ni.com™ are trademarks of National Instruments Corporation.
Product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents

For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents. txt file
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY,
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS.
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN,
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Compliance

FCC/Canada Radio Frequency Interference Compliance

Determining FCC Class

The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only)
or Class B (for use in residential or commercial locations). Depending on where it is operated, this product could be subject to
restrictions in the FCC rules. (In Canada, the Department of Communications (DOC), of Industry Canada, regulates wireless
interference in much the same way.)

Digital electronics emit weak signals during normal operation that can affect radio, television, or other wireless products. By
examining the product you purchased, you can determine the FCC Class and therefore which of the two FCC/DOC Warnings
apply in the following sections. (Some products may not be labeled at all for FCC; if so, the reader should then assume these are
Class A devices.)

FCC Class A products only display a simple warning statement of one paragraph in length regarding interference and undesired
operation. Most of our products are FCC Class A. The FCC rules have restrictions regarding the locations where FCC Class A
products can be operated.

FCC Class B products display either a FCC ID code, starting with the letters EXN, Trade Name  Model Number
or the FCC Class B compliance mark that appears as shown here on the right. FC Tested to Comply
. . . C with FCC Standards

Consult the FCC Web site at http: //www. fcc.gov for more information.
FOR HOME OR OFFICE USE

FCC/DOC Warnings

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions
in this manual and the CE Marking Declaration of Conformity*, may cause interference to radio and television reception.
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department
of Communications (DOC).

Changes or modifications not expressly approved by National Instruments could void the user’s authority to operate the
equipment under the FCC Rules.

Class A

Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct

the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Réglement sur le matériel brouilleur du Canada.

Class B

Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of
the following measures:

» Reorient or relocate the receiving antenna.

» Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

» Consult the dealer or an experienced radio/TV technician for help.



Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur le matériel brouilleur du Canada.

Compliance to EU Directives

Readers in the European Union (EU) must refer to the Manufacturer’s Declaration of Conformity (DoC) for information*
pertaining to the CE Marking compliance scheme. The Manufacturer includes a DoC for most every hardware product except
for those bought for OEMs, if also available from an original manufacturer that also markets in the EU, or where compliance is
not required as for electrically benign apparatus or cables.

To obtain the DoC for this product, click Declaration of Conformity at ni . com/hardref .nsf/. This Web site lists the DoCs
by product family. Select the appropriate product family, followed by your product, and a link to the DoC appears in Adobe
Acrobat format. Click the Acrobat icon to download or read the DoC.

* The CE Marking Declaration of Conformity will contain important supplementary information and instructions for the user
or installer.



Conventions

»

bold

italic

monospace

monospace italic

The following conventions are used in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes DIP switch,
LED, and parameter names.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.
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Overview of the FP-1300

Network Module

This chapter provides an overview of the FieldPoint FP-1300 network
module and the FP-1300 software.

FP-1300 Hardware Overview

With the FP-1300 you can add configurable I/O to any CAN
communication bus. Use NI-CAN hardware and NI-CAN 2.0 or later,
driver software to configure the FP-1300. The FP-1300 has a CAN port,
LED indicators to communicate status information, and DIP switches that
perform various functions.
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Figure 1-1. Overview of the FP-1300
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Chapter 1 Overview of the FP-1300 Network Module

A FieldPoint bank consists of at least one network module, and one or more
terminal base, and I/O modules. Each FP-1300 can support up to nine I/O
modules. The maximum number of FP-1300 network modules that you can
install on the CAN network is limited in theory by the number of unique
arbitration IDs on the network. If you use standard arbitration IDs, you can
install up to eight FP-1300 banks on a single network. If you use extended
arbitration IDs, the number of FP-1300 banks you can install on a single
network is system dependent.

The FP-1300 network module connects directly to a high-speed CAN
network. If you are using NI-CAN, you can use the FP-1300 Configuration
Utility to configure the baud rate of the FP-1300 to match the baud rate of
the CAN network. For more information on configuring the baud rate of the
FP-1300, refer to the FP-1300 Configuration Help. If you are not using
NI-CAN, you cannot use the FP-1300 Configuration Utility and you must
configure the other devices on the CAN network to use the default baud rate
of the FP-1300, which is 500 Kbps. For detailed hardware specifications
and cabling information, refer to Appendix C, Specifications.

| 1 PC with a CAN Card

2 FP-1300 Banks 3 Other CAN Devices

Figure 1-2. FP-1300 CAN Network

FP-1300 Software Overview

FP-1300 User Manual

The National Instruments FP-1300 software consists of NI-CAN software
and the FP-1300 Configuration Utility. The FP-1300 software runs on
Windows 2000/NT/XP/Me/9x and includes the following components:

*  FP-1300 Configuration Utility
e NI-CAN software 2.0 or later

You can download the current version of the FP-1300 software from the NI
FTP site at ni . com/support/.

1-2 ni.com



Chapter 1 Overview of the FP-1300 Network Module

FP-1300 Setup Overview

The following list is an overview of the steps required to set up and run the
FP-1300.

Install the NI-CAN software and hardware as described in the NI-CAN
Hardware and Software Manual.

1.

© National Instruments Corporation

Install the FieldPoint hardware as described in Chapter 2, Installing
and Configuring Hardware and Software.

d.

c.

f.

Mount the FP-1300, terminal bases, and I/O modules.

If you are not using an NI-CAN card with the FP-1300 system,
configure the DIP switches on the FP-1300.

Connect the FP-1300 to the CAN network.
Wire power to the FP-1300 CAN port.
Wire power to the FP-1300 system.

Wire signals to the I/O channels.

Install the FP-1300 Configuration Ultility as described in Chapter 2,
Installing and Configuring Hardware and Software.

Launch Measurement & Automation Explorer (MAX).

Configure the FieldPoint system and verify the configuration,
as described in the FP-1300 Configuration Help.

Deploy the system.

1-3 FP-1300 User Manual



Installing and Configuring
Hardware and Software

This chapter explains how to install the FieldPoint hardware and how
to install and configure the software. Before you install the FieldPoint
hardware, install the other CAN hardware. If you are using NI-CAN
hardware, refer to the NI-CAN Hardware and Software Manual.

What You Need to Get Started

To set up and use the FP-1300, you need the following items:

FP-1300 network module

Mounting hardware (DIN rail or panel-mount accessory)
Terminal base(s) and I/O module(s)

10-30 VDC power supply to power the CAN bus

11-30 VDC power supply to power the FieldPoint bus

I Ny N B N

Accessories: twisted-pair cable, Combicon-style connector, flathead
screwdriver

U Optional accessories: shielded cable, two 120 Q resistors

O Installed and configured CAN card

FieldPoint Safety Information

The following section contains important safety information that you must
follow when installing and using FieldPoint products.

Do not operate the FieldPoint product in a manner not specified in the user
manual or operating instructions. Misuse of the product can result in a
hazard. You can compromise the safety protection built into the product if

© National Instruments Corporation 2-1 FP-1300 User Manual



Chapter 2 Installing and Configuring Hardware and Software

FP-1300 User Manual

the product is damaged in any way. If the product is damaged, return it to
NI for repair.

Do not substitute parts or modify the FieldPoint product. Use the product
only with the modules, accessories, and cables specified in the installation
instructions.

Always operate the FieldPoint product in a suitable enclosure that will
prevent unintentional access to live terminals and will prevent the spread
of fire.

Do not operate FieldPoint products in an explosive atmosphere or where
there may be flammable gases or fumes. If you need to operate FieldPoint
products in such an environment, the FieldPoint products must be in a
suitably rated enclosure. Operate the product only at or below Pollution
Degree 2. Pollution is foreign matter in a solid, liquid, or gaseous state that
can reduce dielectric strength or surface resistivity. The following is a
description of pollution degrees:

*  Pollution Degree 1 means that no pollution or only dry, nonconductive
pollution occurs. The pollution has no influence.

*  Pollution Degree 2 means that only nonconductive pollution occurs in
most cases. Occasionally, however, a temporary conductivity caused
by condensation must be expected.

*  Pollution Degree 3 means that conductive pollution occurs, or dry,
nonconductive pollution occurs which becomes conductive due to
condensation.

If you need to clean a FieldPoint product, use a soft nonmetallic brush.
The product must be completely dry and free from contaminants before it
is returned to service.

You must insulate signal connections for the maximum voltage for which
the FieldPoint product is rated. Do not exceed the maximum ratings for the
product. Do not install wiring while the product is live with electrical
signals. Do not remove or add terminal bases when power is connected to
the FieldPoint system. Avoid contact between your body and the terminal
base signal wiring when hotswapping modules.

2-2 ni.com



Chapter 2 Installing and Configuring Hardware and Software

Operate FieldPoint products at or below the installation category' marked
on the hardware label. Measurement circuits are subjected to working
voltages? and transient stresses (overvoltage) from the circuit to which they
are connected during measurement or test. Installation categories establish
standard impulse withstand voltage levels that commonly occur in
electrical distribution systems. The following is a description of installation
categories:

* Installation Category I is for measurements performed on circuits not
directly connected to the electrical distribution system referred to as
MAINS?3 voltage. This category is for measurements of voltages from
specially protected secondary circuits. Such voltage measurements
include signal levels, special equipment, limited-energy parts of
equipment, circuits powered by regulated low-voltage sources, and
electronics.

* Installation Category II is for measurements performed on circuits
directly connected to the electrical distribution system. This category
refers to local-level electrical distribution, such as that provided by a
standard wall outlet (such as 115 V for U.S. or 230 V for Europe).
Examples of Installation Category II are measurements performed on
household appliances, portable tools, and similar products.

+ Installation Category Il is for measurements performed in the building
installation at the distribution level. This category refers to
measurements on hard-wired equipment such as equipment in fixed
installations, distribution boards, and circuit breakers. Other examples
are wiring, including cables, bus-bars, junction boxes, switches,
socket-outlets in the fixed installation, and stationary motors with
permanent connections to fixed installations.

* Installation Category IV is for measurements performed at the primary
electrical supply installation (<1,000 V). Examples include electricity
meters and measurements on primary overcurrent protection devices
and on ripple-control units.

Mounting the FP-1300 and Terminal Bases

You can mount the FieldPoint system either to a DIN rail or directly on
a panel. Panel mounting is generally the more secure option. The following
sections give instructions for both mounting methods.

! Installation categories, also referred to as measurement categories, are defined in electrical safety standard IEC 61010-1.
2 Working voltage is the highest rms value of an AC or DC voltage that can occur across any particular insulation.

3 MAINS is defined as a hazardous live electrical supply system that powers equipment. Suitably rated measuring circuits may
be connected to the MAINS for measuring purposes.

© National Instruments Corporation 2-3 FP-1300 User Manual



Chapter 2 Installing and Configuring Hardware and Software

Mounting the FP-1300 on a DIN Rail

The FP-1300 network module has a simple rail clip for reliable mounting
on a standard 35 mm DIN rail. Complete the following steps if you choose
to mount the module on a DIN rail.

1.  Write down the serial number from the back of the FP-1300 before you
mount it.

2. Use a flathead screwdriver to open the DIN rail clip to the unlocked

position.
1 Rail Clip Locked 2 Rail Clip Unlocked

Figure 2-1. Unlocking the Rail Clip

3. Hook the lip on the rear of the FP-1300 onto the top of a 35 mm
DIN rail and press the module down onto the DIN rail.

Figure 2-2. Mounting the FP-1300 on a DIN Rail

FP-1300 User Manual 24 ni.com



Chapter 2 Installing and Configuring Hardware and Software

4. Slide the FP-1300 to the desired position on the DIN rail. When it is in
position, lock it to the DIN rail by pushing the rail clip to the locked
position.

-
.

==
=

| S—

Figure 2-3. Locking the FP-1300 on the DIN Rail

Connecting Terminal Bases with DIN Rail Mounting

Complete the following steps to connect a terminal base to an FP-1300
network module using DIN rail mounting.

A Caution To avoid damaging the FP-1300 and the terminal bases, make sure that no power
is applied to the system while you install or remove terminal bases.

1. Mount the terminal base on the DIN rail as detailed in the Mounting
the FP-1300 on a DIN Rail section.

2. Attach the terminal base to the FP-1300 by firmly attaching the local
bus connectors. Be careful not to bend any pins.

3. To add more terminal bases, install them on the rail and connect their
local bus connectors together. In most cases, a single FP-1300
can support up to nine terminal bases, depending on the power
consumption of the I/O modules. Refer to the Powering the FieldPoint
System section for more information about power requirements.

4. Place the protective cover onto the local bus connector of the last
terminal base on the bank. Add the rail locks by sliding them on and
tightening the screws.

© National Instruments Corporation 2-5 FP-1300 User Manual



Chapter 2 Installing and Configuring Hardware and Software

Figure 2-4. Installing the Bus-Protection Cover and the Rail Locks

Removing the FP-1300 and Terminal Bases
from the DIN Rail

Remove an I/O module from its terminal base before lifting the terminal
base off the rail. To remove an FP-1300 network module or terminal base,
unlock it from the DIN rail by placing a flathead screwdriver in the slot on
the rail clip and opening the clip to the unlocked position. After you
disconnect the network module from the local bus connector of the terminal
base, you can lift the terminal base off the rail.

Mounting the FP-1300 to a Panel

FP-1300 User Manual

Complete the following steps if you choose to install the optional
FieldPoint network panel-mount accessory and mount the FP-1300
network module to a panel. You can order the panel-mount accessory,
part number 777609-01, from NI.

1.  Write down the serial number from the back of the FP-1300.

2. Use a flathead screwdriver to open the rail clip to the unlocked

position.
1 Rail Clip Locked 2 Rail Clip Unlocked

Figure 2-5. Unlocking the Rail Clip
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Chapter 2 Installing and Configuring Hardware and Software

3. Snap the panel-mount accessory onto the module.

Figure 2-6. Installing the Panel Mount Accessory

4. Lock the panel-mount accessory into place by pushing the rail clip to
the locked position.
5. Mount the FP-1300 to the panel with the panel-mount accessory. The

installation guide that came with the panel-mount accessory includes a
template that you can use to drill pilot holes for mounting.

Figure 2-7. Attaching the FP-1300 to the Panel

© National Instruments Corporation 2-7 FP-1300 User Manual
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Connecting Terminal Bases with Panel Mounting

You can install terminal bases directly, without using the panel mount
accessory needed to mount the FP-1300 network module. Complete the
following steps to connect terminal bases to the network module using
panel mounting.

A Caution To avoid damaging the FP-1300 and the terminal bases, make sure that no power
is applied to the system while you install or remove terminal bases.

FP-1300 User Manual

1. Drill pilot holes in the panel to mount the terminal bases. A drilling
template is provided with the network module panel-mount accessory.

2. Connect the terminal base to the FP-1300 by firmly attaching the local
bus connectors. Be careful not to bend any connector pins.

3. Bolt, screw, or otherwise fasten the terminal base to the panel. Make
sure that the local bus connectors remain firmly attached after the
terminal base is mounted.

I
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Figure 2-8. Attaching a Terminal Base to the Panel

4. To add more terminal bases, repeat steps 1 to 3, attaching the local bus
connectors of each new terminal base to the connector of the last
installed base. In most cases a single FP-1300 can support up to nine
terminal bases, depending on the power consumption of the I/O
modules. Refer to the Powering the FieldPoint System section for
more information about power requirements.
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If all the pilot holes were correctly drilled, the local bus connectors
should remain firmly attached after all the bases are mounted to the
panel.

5. Place the protective cover onto the local bus connector of the last
terminal base on the bank.

Figure 2-9. Installing the Bus-Protection Cover

Removing the FP-1300 and Terminal Bases from
the Panel

To remove an FP-1300 network module and terminal bases from the panel,
first remove the terminal bases, starting with the last one, then remove the
network module.

Mounting 1/0 Modules onto Terminal Bases

Generally, it does not matter where you install each /O module, except in
the following situations:

* Ifyouplan to cascade power between any I/O modules using the V and
C terminals, group those modules together.

A Caution Cascading power between I/O modules defeats isolation.

»  For more accurate measurements, locate any thermocouple modules
away from heat sources, including network modules and relay
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modules, unless you mount the thermocouple modules on FP-TB-3
isothermal bases.

Refer to Figure 2-10 and complete the following steps to connect an I/O
module to a terminal base.

1. Position the first module with its alignment slots aligned with the guide
rails on the terminal base.

Guide Rails

1/0 Module Terminal Base

Figure 2-10. Installing an 1/0 Module

2. Firmly press the module onto the terminal base. The terminal base
latch locks the I/O module into place when the ejector button pops up
on top of the terminal base.

3. Repeat this procedure to install additional I/O modules onto terminal
bases.

Using DIP Switches to Configure the FP-1300

@ Note If you use the FP-1300 software to configure the FP-1300, you do not need to use
DIP switches to configure the base arbitration ID. Go to the Connecting the FP-1300 to the
CAN Network section.

To configure the base arbitration ID using the DIP switches on the FP-1300,
complete the following steps:

1. Push the USER/DEF switch to the DEF position.

2. Use the STD/XTD switch to configure the arbitration ID type,
standard or extended.

3. Use the remaining DIP switches to configure the base arbitration ID.
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The following sections describe the functions of the DIP switch settings.

i’
20000000000020020202 200000002000020000202
©DOQ000000000000000 ©00000000000000000

ID .

D /" Address Mode

R

K 12345678 ,
AN Operating;L,—I N
.. Mode .-

Figure 2-11. Overview of the FP-1300 DIP Switches

Configuring the Operating Mode

You can configure the FP-1300 to operate in user mode (USER) or
factory-default (DEF) mode using the USER/DEF switch.

In user mode, the FP-1300 reads its baud rate and arbitration ID from the
configuration settings that were last saved in the FP-1300 software. To
configure the module for user mode, push the USER/DEF switch to the
USER position.

12345678

Figure 2-12. USER/DEF Switch in User Mode

In factory-default mode, the FP-1300 baud rate is 500 Kbps and the
FP-1300 reads its base arbitration ID from the DIP switches on the module.
For more information about configuring base arbitration IDs using DIP
switches, refer to the Configuring the Base Arbitration ID section. To
configure the FP-1300 to operate in factory-default mode, push the
USER/DEF switch to the DEF position.

© National Instruments Corporation 2-11 FP-1300 User Manual



Chapter 2 Installing and Configuring Hardware and Software

iy

1234567

Figure 2-13. USER/DEF Switch in Factory-Default Mode

In factory-default mode, the FP-1300 transmits CAN messages for input
I/O data periodically every 500 ms. You can configure the periodic rate as
well as other CAN message transmissions using the FP-1300 Configuration
Utility. Refer to FP-1300 Configuration Help for more information about
configuring CAN messages on the FP-1300.

Configuring the Arbitration ID Type (STD/XTD)

You can configure the FP-1300 to send and receive standard arbitration ID
messages or extended arbitration ID messages. For more information on
standard and extended messages, refer to the NI-CAN Hardware and
Software Manual. If you want the FP-1300 to send 11-bit standard ID
messages, push the STD/XTD switch to the STD position.

12345678

Figure 2-14. STD/XTD Switch in Standard Arbitration ID Mode

If you want the FP-1300 to send 29-bit extended ID messages, push the
STD/XTD switch to the XTD position.

TTTE

123456

Figure 2-15. STD/XTD Switch in Extended Arbitration ID Mode

Configuring the Base Arbitration ID

FP-1300 User Manual

Each FP-1300 on a CAN network must have a unique base arbitration ID.
All CAN messages sent or received by the FP-1300 have arbitration IDs
that are offset from the base arbitration ID of the FP-1300. The FP-1300
configures the CAN message arbitration IDs, but you can change this
configuration using the FP-1300 Configuration Utility. For more
information about the CAN message arbitration IDs default configuration,
refer to the FP-1300 CAN Message Arbitration IDs section.
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Configuring the Base Arbitration ID of an FP-1300
in Standard Mode

If you configure the module to operate in standard mode, use DIP switches
4,5, and 6 to configure the three most significant bits of the base arbitration
ID. The switch represents a 1 in the OFF (up) position and a 0 in the ON
(down) position. Table 2-1 shows some of the possible base arbitration IDs
for an FP-1300 in standard mode. Switch 7 in Table 2-1 indicates that the
FP-1300 is in standard mode.

Table 2-1. Base Arbitration ID Switch Settings for an FP-1300 in Standard Mode

Address Switches
Positions 4-6

Base Arbitration ID Positions 4-6 Base Arbitration ID

Address Switches

III%ﬁI 0 1y 5%' 0x100 (256)
12545678 12345678
TR 0x700 (1,792) nss 0x300 (768)
12345678 12345678

Configuring the Base Arhitration ID of an FP-1300
in Extended Mode

If you configure the module to operate in extended mode, use DIP switches
1-6 to configure the six most significant bits of the network address. You
can configure the remaining 15 bits, which default to 0, through the
FP-1300 Configuration Utility. Refer to FP-1300 Configuration Help for
more information about configuring the remaining 15 bits. Table 2-2
shows some of the possible network addresses for an FP-1300 in extended
mode. Switch 7 in Table 2-2 indicates that the FP-1300 is in extended
mode.

Table 2-2. Base Arbitration ID Switch Settings for an FP-1300 in Extended Mode

Address Switches
Positions 1-6

Base Arbitration ID Positions 1-6 Base Arbitration ID

Address Switches

%%%5 I 0 dgéddﬁd I 0x800000 (8,388,608)
12345678 12345678

@@@@@@ 0x1F800000 @@@@@ 0xF800000
12345 6@! (5;8’482’304) a 2345 e@! (2209046,848)
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FP-1300 CAN Message Arbitration IDs

In the default mode, the FP-1300 configures the arbitration IDs of the CAN
messages that contain FieldPoint I/O channel data using the base arbitration
ID. Since the lower 8 bits are reserved for this purpose, a range of 255 IDs
is possible. The FP-1300 reserves the first two IDs (0 and 1—offset from
the base arbitration ID) for communicating configuration information with
the FP-1300 Configuration Utility. Arbitration ID offsets 2-255 are used
for transmitting I/O channel data. For example, if the base arbitration ID of
the FP-1300 is 0x300, arbitration IDs 0x300 and 0x301 are used by the
FP-1300 Configuration Utility. Arbitration IDs 0x302—0x3FF are used for

transmitting I/O channel data.

The FP-1300 allocates channels to the first arbitration ID beginning with
the first module and channel. Each analog channel uses 2 bytes of
arbitration ID. Each discrete channel uses 1 bit of arbitration ID. Therefore,
in a CAN message (8 data bytes) you can assemble a maximum of

four analog channels or 64 digital channels. The FP-1300 will not mix
input and output I/O channels in the same arbitration ID.

@ Note By default, the FP-1300 begins a new arbitration ID on a new module.

For example, a typical FP-1300 bank consists of the following I/O modules:
*  Module 1: FP-AI-100 (8-channel analog input module)

*  Module 2: FP-AO-200 (8-channel analog output module)

*  Module 3: FP-DO-401 (16-channel discrete output module)

Assuming that the base arbitration ID is set to 0x300, the data IDs are

configured as shown in Table 2-3.

Table 2-3. FP-1300 Arbitration ID Configuration

ID Byte Module Channel Comment
0x300 Reserved for configuring the FP-1300 module using the FP-1300
Configuration Utility
0x301 Reserved for configuring the FP-1300 module using the FP-1300
Configuration Utility
0x302 0,1 1 0 2 bytes per
analog channel
0x302 2,3 1 1 2 bytes per
analog channel

FP-1300 User Manual
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Table 2-3. FP-1300 Arbitration ID Configuration (Continued)

Chapter 2

Installing and Configuring Hardware and Software

1D Byte Module Channel Comment
0x302 4,5 1 2 2 bytes per
analog channel
0x302 6,7 1 3 2 bytes per
analog channel
0x303 0,1 1 4 2 bytes per
analog channel
0x303 2,3 1 5 2 bytes per
analog channel
0x303 4,5 1 6 2 bytes per
analog channel
0x303 6,7 1 7 2 bytes per
analog channel
0x304 0, 1 2 0 2 bytes per
analog channel
0x304 2,3 2 1 2 bytes per
analog channel
0x304 4,5 2 2 2 bytes per
analog channel
0x304 6,7 2 3 2 bytes per
analog channel
0x305 0,1 2 4 2 bytes per
analog channel
0x305 2,3 2 5 2 bytes per
analog channel
0x305 4,5 2 6 2 bytes per
analog channel
0x305 6,7 2 7 2 bytes per
analog channel
0x306 0,1 3 0-16 1 bit per discrete
channel, 2 bytes
for 16 channels
© National Instruments Corporation 2-15 FP-1300 User Manual
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@ Note You can change the base arbitration ID and the method used to assemble I/O channel
data into CAN messages using the FP-1300 Configuration Utility. You can place an I/O
channel into only one arbitration ID.

To configure CAN messages using the FP-1300 Configuration Utility, refer
to the FP-1300 Configuration Help.

Connecting the FP-1300 to the CAN Network

A Caution Before you connect the FP-1300 to a CAN network, make sure the baud rates of
the FP-1300 and the CAN network are the same. If you are configuring the FP-1300 for the
first time and the CAN network is operating at a baud rate other than 500 Kbps, configure
the FP-1300 to operate at the appropriate baud rate before you install it on the CAN
network. If you do not, CAN network errors can occur, and other CAN devices on the
network can go into an error state. Refer to F/P-1300 Configuration Utility Help for more
information about configuring the baud rate.

Connecting the CAN Cable to the FP-1300

If you connect the FP-1300 to a multiple-device CAN network that is
already terminated, refer to the Powering the FieldPoint System section.
If the FP-1300 is the only device connected to the CAN interface, complete
the following steps.
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1. Plug the Combicon-style connector into the CAN port.

Figure 2-16. CAN Port Terminals on the FP-1300

2. Connect a twisted-pair cable to the CAN_H and CAN_L terminals.
The maximum recommended cable length between the FP-1300 and
the CAN network is 0.3 m (12 in.). CAN_H and CAN_L carry the data
on the CAN network.

3. Connect a 10-30 VDC power supply to the V+ and V— terminals.
V+ and V- supply bus power to the CAN bus on the FP-1300.

4. Ifyou are using shielded cable, connect one end of the shield to the
Shield terminal. This connection is not required for all CAN networks.
Connecting a cable shield to the Shield terminal helps reduce noise.

5. Connect the other end of the CAN cable to a connector on the CAN
network.
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Terminating the CAN Network

If you connect the FP-1300 to a multiple-node CAN network that is already
terminated, refer to the Powering the FieldPoint System section. If you

connect the FP-1300 to a single-node CAN network, you need to terminate
the network. To terminate the CAN network, complete the following steps:

1. Installa 120 Q resistor between the CAN_H and CAN_L terminals on
the FP-1300.

2. Install another 120 Q resistor at the other end of the CAN cable
between the CAN_H and CAN_L terminals.

After you have terminated the CAN network, verify that the total resistance
between CAN_H and CAN_L is 60 Q.

Powering the FieldPoint System

Each FP-1300 on the network requires an 11-30 VDC power supply. The
FP-1300 filters and regulates this supplied power and provides power for
all the I/O modules in the bank. Therefore, you do not need to provide
power separately to each FieldPoint I/O module in the bank.

Calculating Power for a FieldPoint Bank

FP-1300 User Manual

The power requirements for a FieldPoint bank that uses an FP-1300
network module are calculated as follows:

Power=1W + 1.1 X Z(I/O Module Consumption)

This is the amount of power the FP-1300 network module consumes from
the power supply to power itself and the I/O modules. It does not include
any power consumed by devices that you wire to the terminal bases. The

CAN bus requires a separate power supply.

The FP-1300 supplies 9 W of power to the I/O modules. Using I/O modules
that consume more than 1 W can reduce the total number of I/O modules
allowed in the bank to less than nine. Refer to the operating instructions for
each I/0 module for power consumption information.
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Connecting Power to the FieldPoint System

A Caution Before you power up the FP-1300 on a process-critical CAN network, make sure
that the FP-1300 and the CAN network have the same baud rate. Also make sure that the
FP-1300 is using a unique arbitration ID.

Complete the following steps to connect power to the FieldPoint system:

1.

Connect the 11-30 VDC power supply leads to the V and C terminals
of the network module. Connect the positive lead to V and the negative
lead to C.

Connect power to the FieldPoint modules that require external power
for inputs or outputs (such modules include output modules, counter
modules, PWM, PG, and QUAD). Refer to the operating instructions
of the I/O module for power requirement details. You can power a
module by connecting the V and C inputs on its terminal base to a
separate power supply, connecting the V and C outputs of a
neighboring terminal base or network module, or using a combination
of' both methods. If you want to power field I/O devices from a terminal
base, supply power to the terminal base, then connect the terminal base
V and C output terminals to the field device.

Caution Cascading power from neighboring bases or network modules defeats isolation
between cascaded modules.

Figure 2-17 shows an example of a FieldPoint system wired to power
sources.

© National Instruments Corporation
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Separate Power Supply
(Recommended)

Cascaded Power
(Reduces Isolation)

3

No External
Power Required
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CAUTION: Cascading
power defeats isolation.

Figure 2-17. Connecting Power to the FieldPoint Bank

Connecting to Field Devices

Refer to the operating instructions for each I/O module to connect the field

devices.

Powering On the FP-1300

Caution Before powering-on the FieldPoint system, make sure that the FP-1300 and the
CAN port to which it connects are operating at the same baud rate. Also make sure that the
arbitration IDs for the FieldPoint banks are unique on the CAN network.

Plug in each power supply to the FieldPoint bank and to the CAN network.
At power-on, the FP-1300 runs a power-on self test (POST) that takes
several seconds. You should see the POWER LED light up. After about
five seconds, the MODULE STATUS and CAN STATUS LEDS flash
green, then red, and then turn solid green indicating that the FP-1300 is
transmitting messages. If the LEDs do not light up as described here, check
the power supply connections and refer to Appendix A, LED Indicators.
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If you are using an NI-CAN card with the FP-1300, refer to the /nstalling
the FP-1300 Software section. If you are not using an NI-CAN card when
configuring the FP-1300, the installation is complete because you must use
the FP-1300 and FieldPoint I/O modules in the default modes.

Installing the FP-1300 Software

E Note Ifyou are not using an NI-CAN card when configuring the FP-1300, you cannot use
the FP-1300 software.

The host computer must be running Windows 2000/NT/XP/Me/9x.
Complete the following steps to install the FP-1300 software on the host
computer:

1.

Close all other applications.

2. Insert the FP-1300 Software CD into the CD-ROM drive on the host
computer.
3. Follow the onscreen instructions to complete the installation.
E Note If the setup does not launch automatically, select Start»Run from Windows, enter

x: \setup, where x is the letter of the CD-ROM drive, and select OK.

Configuring the FP-1300 Software

Complete the following steps to configure the FP-1300 software:

1.

© National Instruments Corporation

Select Select»Programs»National Instruments»Measurement &
Automation to launch MAX.

If you do not see the CAN port to which the FP-1300 connects, press
<F5> to refresh MAX.

In the MAX configuration tree, right-click the CAN port to which the
FP-1300 connects and select FP-1300 Config.

Refer to the F/P-1300 Configuration Help and complete the following
tasks:

a. Configure the baud rate.

b. Configure the base arbitration ID.

c. Configure the I/O module attributes and settings.
d. Configure the CAN messages.

e. Save the configuration.
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LED Indicators

The FP-1300 has three LEDs that communicate information. Use
Table A-1 to interpret the FP-1300 LED indicators.

Table A-1. FP-1300 LED Indicators

LED Solid Green Flashing Green Solid Red Flashing Red

POWER Power is applied — — —
to the FP-1300.

MODULE The FP-1300 is I/O data has The FP-1300had | The FP-1300 had

STATUS operating stopped because | anunrecoverable | arecoverable
normally. the FP-1300 is fault. Cycle the fault. Try using

communicating power. the FP-1300
with the Configuration
Configuration Utility to resolve
Utility. the issue.

CAN STATUS The CAN bus is — There is an error | There is a
transmitting on the CAN bus | message
messages. and the CAN overflow on the

communication FP-1300 CAN

has stopped. controller. In the
Configuration
Utility, select
Reset»Cycle
Power.

@ Note Refer to Appendix B, Troubleshooting, for more information about the LED
indicators.
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Troubleshooting

This appendix provides troubleshooting instructions for the FP-1300 and
the FP-1300 Configuration Utility.

When I startup my system the MODULE STATUS LED is flashing red.
What causes this problem and how do I correct it?

A MODULE STATUS LED that flashes red at startup indicates the FP-1300
has a recoverable fault. The most likely cause is that the current I/O does
not match the saved configuration. Simply use the FP-1300 Configuration
Utility to save the new I/O configuration. It can also indicate that a hotswap
with an incompatible module has occurred.

The MODULE STATUS and CAN STATUS LEDs turn red soon after
startup. What causes this condition?

This condition is usually caused when FP-1300 is configured at a different
baud rate than the rest of the network. Run the FP-1300 Configuration
Utility to change the baud rate of the FP-1300.

I don’t know the baud rate and/or base arbitration ID of the FP-1300.
‘What should I do?

1. Move the USER/DEF switch to the DEF setting.

2. Power the FP-1300 off, then on. The baud rate is set to 500 kb/s and
the base arbitration ID is set according to the address switches.

3. Use the FP-1300 Configuration Utility to modify the baud rate and
base arbitration ID of the module. For more information refer to
FP-1300 Configuration Utility Help.

4. If you want the I/O and message configuration to revert to the default
settings, double-click the device to open its I/O configuration screen
and save to the device here. If you want to keep the original I/O and
message configuration, do not double-click the device.

5. Move the USER/DEF switch to the USER setting and power the
FP-1300 off, then on.
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Appendix B Troubleshooting

Can I hotswap an I/O module with a different I/O module while my
FP-1300 is running?

When you are using the FP-1300, you can hotswap an I/O module only with
the same model I/0 module. If you need to swap an I/O module with a
different model I/O module, you must reset the FP-1300 and reconfigure
the I/O module using the FP-1300 Configuration Utility.
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Specifications

Installation
Terminal Wiring.........cccecevvevienveneneennne 16-26 AWG copper conductor
wire with 7 mm (0.275 in.) strip
length
Torque for screw terminals ....................... 0.5-0.6 N-m (4.4-5.3 1b-in.)
Network
Network interface.........coeeeveveencninencnnene CAN
Compatibility .....cceoveieieiiiiieeeee ISO 11898
Communication rates ...........c.eeverveereennenne Up to 1 Mbps

Maximum cabling distance at 1 Mbps.......Refer to ISO 11898-2
CAN bus power supply range ................... 10-30 VDC

CAN bus power consumption

Typical ooeeeeeeieieeeieeee e 0.72 W (30 mA at 24 VDC)
MaXimMUM ....coveeeverieeveieeeenieeeereeeeens 3w
CAN bus isolation.........cceeeveeeveenreeneennen. 250 Vs Operational,
2,500 V,,,s breakdown

FieldPoint bank power supply range......... 11-30 VDC
FieldPoint bank power consumption
Power=1W + 1.1 X Z(I/O Module Consumption)

Maximum I/O terminal bases per bank.....9

Maximum number of banks....................... Determined by network
topology
Weight ..o, 254 g (8.96 0z)

© National Instruments Corporation c-1 FP-1300 User Manual



Appendix C Specifications

Isolation Voltage

For isolation voltage ratings, refer to the I/O module specifications and
labels.

Environmental

FieldPoint modules are intended for indoor use only. For outdoor use, they
must be mounted inside a sealed enclosure.

Operating temperature ............cceceeeeeeennen. —40 to 70 °C

Storage temperature ............eeeveeeveervernennns —55t085°C

Humidity .....cooovvvieeiiceeieeeeee e 10 to 90% RH, noncondensing
Maximum altitude............cooovveiiiiiinnnneenn. 2,000 m

Pollution Degree.........coceeveveerveeereeiennnn 2

Safety

The FP-1300 is designed to meet the requirements of the following
standards for safety and electrical equipment for measurement, control, and
laboratory use.

+ EN61010-1, IEC 61010-1
« UL3I121-1
+ CAN/CSA C22.2 No. 1010.1

For certifications under regulatory standards, including hazardous location
standards, refer to the product label or to ni . com.

Electromagnetic Compatibility
CE, C-Tick, and FCC Part 15 (Class A) Compliant

EMissions.....ccvevveerveeieeieeieeie e EN 55011 Class A @ 10 m
FCC Part 15A above 1 GHz
IMMUNILY .ovveeriiieeieeeeeeeeeeee e EN 61326-1: 1998, Table 1
@ Note For full EMC compliance, you must operate this device with shielded cabling.
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CE Compliance

This product meets the essential requirements of applicable European
Directives as amended for CE Marking.

Low-Voltage Directive (safety) ................ 73/23/EEC
Electromagnetic Compatibility
Directive (EMC) ...ccvevvveeeciieieeie e, 89/336/EEC

@ Note See the Declaration of Conformity (DoC) for this product for any additional

regulatory compliance information at ni . com. The DoC may be found using the search
utility and the product model number.
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Technical Support and
Professional Services

Visit the following sections of the National Instruments Web site at
ni . com for technical support and professional services:

*  Support—Online technical support resources include the following:

Self-Help Resources—For immediate answers and solutions,
visit our extensive library of technical support resources available
in English, Japanese, and Spanish at ni . com/support. These
resources are available for most products at no cost to registered
users and include software drivers and updates, a KnowledgeBase,
product manuals, step-by-step troubleshooting wizards, hardware
schematics and conformity documentation, example code,
tutorials and application notes, instrument drivers, discussion
forums, a measurement glossary, and so on.

Assisted Support Options—Contact NI engineers and other
measurement and automation professionals by visiting
ni.com/ask. Our online system helps you define your question
and connects you to the experts by phone, discussion forum,

or email.

*  Training—Visitni.com/custed for self-paced tutorials, videos, and
interactive CDs. You also can register for instructor-led, hands-on
courses at locations around the world.

*  System Integration—If you have time constraints, limited in-house
technical resources, or other project challenges, NI Alliance Program
members can help. To learn more, call your local NI office or visit
ni.com/alliance.

If you searched ni . com and could not find the answers you need, contact
your local office or NI corporate headquarters. Phone numbers for our
worldwide offices are listed at the front of this manual. You also can visit
the Worldwide Offices section of ni . com/niglobal to access the branch
office Web sites, which provide up-to-date contact information, support
phone numbers, email addresses, and current events.

© National Instruments Corporation

D-1 FP-1300 User Manual



Glossary

Prefix Meaning Value
p- pico- 10-12
n- nano- 10-°
p- micro- 10-¢
m- milli- 10-3
k- kilo- 103
M- mega- 106
G- giga- 10°
T- tera- 1012

° degrees
Q ohms
% percent

A

arbitration ID an 11- or 29-bit ID transmitted as the first field of a CAN frame. The
arbitration ID determines the priority of the frame, and is normally used to
identify the data transmitted to the frame.

b bits

B bytes
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Glossary

bank

bps

CAN

CAN remote frame

D

DIP switch

E

extended arbitration ID

ft

FTP

H

hex
HotPnP

Hz

FP-1300 User Manual

the combination of one FieldPoint network module and one or more
terminal bases and I/O modules

bits per second

Celsius
controller area network

used to request data for a CAN object from a remote node

dual inline package switch

a 29-bit arbitration ID

feet

file transfer protocol

hexadecimal
hot plug and play

hertz

G-2

ni.com



Glossary

/0 input/output

IEC International Electrotechnical Commission
in. inch or inches

ISO International Standards Organization

KB kilobytes of memory

LED light-emitting diode

m meters

MB megabytes of memory

P

PC personal computer
periodic a type of message that transfers at regular user-specified intervals
polled request/response connection in which a request for data is sent to a device,

and the device sends back a response with the desired value

POST power-on self test

S

standard arbitration ID an 11-bit arbitration ID
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v

\" volts
vDC volts direct current
Vims volts root mean squared

FP-1300 User Manual G4 ni.com



Index

C

cleaning your FP-1300, 2-2
configuration
connecting to field devices, 2-20
overview, 1-3
contacting National Instruments, D-1
conventions used in the manual, vi
customer
education, D-1
professional services, D-1
technical support, D-1

D

diagnostic resources, D-1
DIN rail mount. See installation, mounting
hardware on DIN rail
documentation
online library, D-1
drivers
instrument, D-1
software, D-1

E

Ethernet network
connections
figure, 1-2
example code, D-1

F

FieldPoint bank (definition), 1-2
FieldPoint safety information, 2-1
FieldPoint software
configuration, 2-21
FTP download site, 1-2
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installation, 2-21
overview, 1-2
FP-1300 hardware
installation
mounting FP-1300 on DIN rail, 2-4
mounting FP-1300 to panel, 2-6
power supply to I/O modules, 2-18
powering, 2-18
figure, 2-19
powering up, 2-20
safety information, 2-1
setup overview, 1-3
frequently asked questions, D-1
FTP
National Instruments FTP site, 1-2

H

help
professional services, D-1
technical support, D-1

/O modules
connecting to field devices, 2-20
mounting on terminal bases, 2-9
powering, 2-18, 2-19
installation
category, 2-3
mounting hardware on DIN rail
connecting terminal bases, 2-5
mounting FP-1300, 2-4
removing FP-1300 and terminal bases,
2-6
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mounting hardware to a panel
connecting terminal bases, 2-8
FP-1300 mounting procedure, 2-6
panel mount accessory, 2-6, 2-8
panel mount accessory (figure), 2-7
removing FP-1300 and terminal
bases, 2-9
mounting I/O modules onto terminal
bases, 2-9
overview, 1-3
power connections, 2-18
figure, 2-19
instrument drivers, D-1
isolation
defeated by cascading power
caution, 2-19
figure, 2-19

K

KnowledgeBase, D-1

L

LED indicators
power-on self test (POST), 2-20

local bus connector, protective cover (figure),
2-5,2-9

mounting hardware on DIN rail. See
installation, mounting hardware on DIN rail

mounting hardware to a panel. See installation,
mounting hardware to a panel

National Instruments
customer education, D-1
professional services, D-1
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system integration services, D-1
technical support, D-1
worldwide offices, D-1

0

online technical support, D-1
overview
FieldPoint software, 1-2
setup, 1-3

P

panel mount. See installation, mounting
hardware to a panel
phone technical support, D-1
pollution degree, 2-2
power connections
calculating power for FieldPoint bank,
2-18
figure, 2-19
wiring, 2-18
power supply, 2-18
power-on self test (POST), 2-20
power-up
overview, 2-20
professional services, D-1
programming examples, D-1

R

rail clip, 2-4, 2-6

removing FP-1300 and terminal bases
DIN rail mount, 2-6
panel mount, 2-9
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S

safety information, 2-1
software drivers, D-1
support
technical, D-1
system integration services, D-1

T

technical support, D-1
telephone technical support, D-1
terminal bases
connecting with DIN rail mount, 2-5
connecting with panel mount, 2-8
powering, 2-18
removing with DIN rail mount, 2-6
removing with panel mount, 2-9
training
customer, D-1
troubleshooting resources, D-1
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Index

W

Web

professional services, D-1

technical support, D-1
wiring

field devices, 2-20

power, 2-18

figure, 2-19

worldwide technical support, D-1
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